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Welcome to the BioCAM DupleX platform and thank you for your purchase. The BioCAM DupleX plat-
form is among the most advanced systems for managing your experiments on the emerging genera-
tion of high-density CMOS-MEAs. This manual has been written to help you in taking advantage of all 
functionalities provided by your BioCAM DupleX. Be sure to read this manual thoroughly, and to keep it 
handy when using the BioCAM DupleX platform.

Before any use of your BioCAM DupleX platform, please read the “Precautions” P.14, which contains 
relevant information to preserve your HD-MEAs and BioCAM DupleX from possible damages.

MEA technology
Among the different methodologies used for electrophysiological measures, metal microelectrodes in-
tegrated on-chip can provide multisite measures of extracellular signals with a high signal-to-noise ratio. 
In addition, by applying voltage or current stimuli to the same microelectrodes it is possible to depolar-
ize cells or tissues, thus establishing bi-directional interfaces. As established over several decades of 
research, both sensing and actuating performances of microelectrodes can be applied to study a wide 
range of electrogenic cells and tissues, including neuronal and cardiac preparations. 

Conventional microelectrode arrays (MEAs) are bio-sensing chips realized by means of thin-film tech-
nologies and do not integrate any on-chip microelectronic circuit. Therefore, conventional MEAs are 
passive devices made on silicon, glass or polymeric substrates. Each microelectrode can be made by 
different materials (e.g. Pt, IrOx, TiN) and it is individually wired on-chip and connected to an external 
amplifier and data acquisition (DAQ) instrument. Due to the need of this MEA technology of individually 
routing on-chip each electrode, space constraints and wiring encumbrance impede the realization of 
dense and large electrode arrays. Thus, for conventional MEAs the typical electrode pitch is in the range 
of 100 µm and the array includes from 60 up to 256 microelectrodes. In addition, given the distance 
between the electrodes and the off-chip amplifiers and the use of interconnecting wires, conventional 
MEAs are subjected to inductive coupling noise.

CMOS-MEA technology
The electrode density and array sizes can be increased by changing the technology used to realize 
microelectrode arrays (MEAs). High-density MEAs are realized with complementary metal–oxide–semi-
conductor technology (CMOS), as it is done for microelectronic devices (e.g., computer microproces-
sors) and light-imaging devices (e.g., camera sensor), and with post-processing methods to optimize the 
electrode performances.

In short, the CMOS technology allows the realization of active electrode-pixels integrated in small areas 
of a few square micrometers electrodes, amplifiers and signal conditioning circuits in-pixel, just under-
neath each electrode site. On-chip, additional amplification stages, time-division multiplexing and high-
speed addressing circuits are provided. 
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In particular, the circuit architecture of 3Brain’s HD-MEAs is based on the Active Pixel Sensor concepts, 
as commonly used for light imaging CMOS cameras, and was therefore designed to allow full array 
recordings at sufficiently high sampling frequency for each electrode.

In HD-MEA, the local in-pixel buffers underneath each electrode allow to locally adapt signals from high 
impedance (electrode-side) to low impedance (wiring-side) to avoid the induction of coupling noise 
from electrical wiring before amplification. Additionally, the on-chip multiplexing and addressing circuits 
allow the minimization of the number of wiring outputs despite the large number of electrodes that is 
to be simultaneously measured. Indeed, each electrode signal is not individually wired off-chip. Rather, 
signals of multiple electrodes are multiplexed at high frequency over a few number of wires. In this way, 
several thousands of electrodes can be recorded on only a few tens of output wires. 

The in-pixel circuit implemented in HD-MEAs allows recordings from a large signal bandwidth that 
includes field potentials and spikes. Instead of implementing an AC-coupling solution that would 
require large areas for the integration of adequate capacitors, the HD-MEAs in-pixel circuit integrates 
an auto-zeroing circuit that is regularly calibrated to the electrode DC voltage and that subtracts this 
calibrated DC voltage from the electrode signal before the first amplification stage.  This process is 
called calibration and it also allows the adaptation of the circuit performance to different experimental 
conditions. In particular, all CMOS devices are photosensitive and photo-generated charges give rise to 
different DC drifting times that can bring in-pixel amplifiers to saturate. HD-MEAs mitigate these effects 
and hence allow experiments under light stimulation conditions (as required for instance for retina 
stimulation) using higher calibration frequencies to keep the DC input signal at the working point of the 
amplifier and to avoid the saturation of the amplifier.
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Overview 
The BioCAM DupleX is the latest generation of our single HD-MEA recording platforms. Similarly to the 
BioCAM X, it allows the acquisition of data from our CMOS high-density MEAs. However, with BioCAM 
DupleX’s improved and completely re-designed electronics, this provides an advanced on-line da-
ta-processing compatibility with the latest Accura MEAs. The Accura MEAs feature recording/stimula-
tion from any of the 4096 electrodes, an integrated circuity to handle the reference ground on chip and 
a motorized locking mechanism to improve connection reliability of the system with the MEA. 

Either your biological models are primarily neuronal cultures, human-derived stem cell preparations, 
cardiac cells or brain tissues as slices, retinas or organoids, the optimized electronics of the BioCAM 
DupleX will be able to detect both slow oscillations (field potentials) as well as spiking activity with 
unprecedented sensitivity. Examples of recordings provided by different laboratories using the BioCAM 
platforms are available on the 3Brain website and uploads of novel examples based on your research 
are warmly welcomed. 

Overall, the platform consists of three basic components: 

1.	 A  multiuse HD-MEA cartridge available in different models and incorporating the CMOS-MEA 
silicon chip; 

2.	 The acquisition BioCAM DupleX hardware that reads out electrophysiological signals from the HD-
MEA;  and provide electrical stimulation trough the electrodes (Accura chip model only).

3.	 A high performance host PC with pre-installed BrainWave 4, our latest all-in-one software genera-
tion to acquire, visualize, store and analyse the data recorded by the BioCAM DupleX.
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Supported HD-MEAs

Khíron (Gen 3)

    Accura       Accura 3D

Artemis (Gen 2)

     Arena         Stimulo                                                

HD-MEA
The HD-MEA cartridge integrates on an electronic substrate, the CMOS-MEA chip and a reservoir cham-
ber to maintain cultures or tissues that goes in contact with the electrode array either under cell culture 
media or perfused media, respectively. The cartridge is 54 mm x 54 mm (2-1/8 in x 2-1/8 in) in size and is 
conceived to be placed in an incubator for cells or tissue cultures.

•	 Contact pads : gold-plated pads for connection between the HD-MEA and the BioCAM DupleX. Prop-
erly cleaned and non-oxidized pads are needed for a stable connection.

•	 PCB : the printed circuit board substrate of the HD-MEA. Different colors are available and according 
to the layout of the CMOS-MEA.

•	 Reservoir : a bio-compatible plastic chamber for the bath solution used for the biological preparation. 
The volume of solution that can be contained is of about 2mL. The external ring defining the reservoir 
volume has an external diameter 28mm (1-7/64 in), internal diameter 25mm (0-63/64 in), height 5mm 
(0-13/64 in).

•	 CMOS-MEA : chip integrating thousands of active electrodes for high-resolution electrophysiological 
recordings from cells or tissues placed on its active area. Different application-specific MEA layouts 
according to the HD-MEA model are available. 

•	 Reference Electrode : two large gold pads integrated into the reservoir to provide the reference 
ground. Implemented to avoid the usage of an external ground reference.

Contact pads

PCB

ReservoirCMOS-MEA

Reference-
electrode

(stimulating 
electrodes not 

supported)

Apollo (Gen 1)

           Prime                         
(soon)                      
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BioCAM DupleX
The BioCAM DupleX is the station where HD-MEAs are plugged into for electrophysiological measures. 
This instrument is compatible with all MEA Probe types including also those with electrical stimulation 
capabilities. It contains all the electronics, real-time hardware and logic to control the CMOS-MEAs chips 
on the HD-MEA cartridges and to acquire and pre-process large-volume of electrophysiological data 
before sending it to the host PC.

•	 Lock button : automatically locks the HD-MEA chip into the bay when initially pressed. Pressing again 
will release the chip. Lock/unlock status can be checked by the LED lock light indications. 

•	 LED light display : BioCAM DupleX provides a set of LEDs to monitor powering, recording and chip 
lock/unlock status 

•	 Peltier-Element : active element to control the temperature of your preparation on HD-MEAs

•	 HD-MEA bay : bay for inserting the HD-MEA and connecting it to the BioCAM DupleX.

Lock button

LED light displayPeltier-Element

HD-MEA bay

•	 Magnetic plates : ferromagnetic stainless steel to attach magnetic holders (e.g., for perfusion).

•	 HD-MEA slot : the slot through which the HD-MEA (contact pads side) is inserted into the DupleX for 
electrical interfacing. 

•	 Bay Barrier & HD-MEA connector : immediately behind the HD-MEA slot, a protective movable Bay 
Barrier blocks accidental overflows of liquids that might get in touch and damage the internal electron-
ics. Behind the Bay Barrier, the HD-MEA connector allows to connect the HD-MEA’s contact pads to 
the internal circuitry. Electrical contacts are established only once the locking system is activated.

Magnetic plates

HD-MEA slot Bay barrier & HD-MEA connector
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•	 Cooling fans : releases excess heat generated from the core of the DupleX. It is mandatory to allow 
airflow and not be blocked directly against any obstacles.

•	 Power button : push-button to power ON or OFF off the DupleX (the instrument needs to be connect-
ed to a power line using the provided adaptor).

•	 PC link : the UCB-C provides a connection for streaming the electrophysiological data from the DupleX 
to the host PC. It is also used by BrainWave 4 to provide BioCAM DupleX firmware updates. 

•	 BCExt connector : plug the external connector box (BX110A) to access extended functionalities such us 
triggering and stimulation. 

•	 Power port : plug for the power supply unit.

Power button PC link BCExt connector
Grounding 
Point Power port

Cooling fans
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BrainWave 4
BrainWave 4 is a complete software application developed to exploit all the functionalities of your Bio-
CAM DupleX platform. It is equipped with advanced tools adapted to manage high-resolution electro-
physiological data acquired from HD-MEAs. When launched it appears as follows (without experiments 
ongoing):

•	 Main Menu: access main functions by clicking on the main menu.

•	 Cursor tools: here you can change the behavior of your cursor 

•	 Windows: contains dockable windows that are automatically updated according to the currently se-
lected experiment loaded into the Experimental viewer. Windows allow you to modify the experiment’s 
options and parameters which can allow you to modify different properties of your experiments. These 
windows can be shown or hidden by choosing the Window menu on the Main Menu

•	 Experimental Viewer: arena for visualizing online and offline experiments through tabs.
•	 Right Status Bar: notifies you about the status of the controlled devices. It displays LED icons for Bio-

CAM DupleX and HD-MEA devices. If the LED icon on the left side displays with “DX“ in representation 
of the DupleX, then it is properly connected and recognized. The display on the right “[...]” will light up 
when a HD-MEA is correctly placed and locked in as well.

Main menu Cursor toolsWindows Experimental viewer

Status barTimeline

BrainWave 4 Video Tutorials
Scan this QR Code to get to multiple BrainWave 4 Video tutorials that we’ve set up for additional guid-
ance. Direct link is : https://www.youtube.com/user/3BrainGmbH/playlists?view=50&sort=dd&shelf_id=1

Disconnected DupleX or HD-MEA 
Error (hover for details)

DupleX & HD-MEA 
Recognized

DupleX        
Recognized

https://www.youtube.com/user/3BrainGmbH/playlists?view=50&sort=dd&shelf_id=1
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BioCAM DupleX handling and use 
The BioCAM DupleX instrument is made with a solid metal case and with optimized electronics that 
make the system robust to mechanical and vibrational noise. Even if it is recommended, the BioCAM 
DupleX’s  installation on an anti-vibration table is not mandatory. 

Moreover, the instrument has been design to be shielded from external electrical environmental noise. 
However, to guarantee optimal recording performances simple precautions as listed below here should 
be followed:

•	 Position the BioCAM DupleX far from potential strong noise sources, such as fridges, incubators etc… 
Indeed, if not well shielded these instruments might generate electromagnetic noise.

•	 Connect the BioCAM DupleX to adequate power lines with low noise levels.

•	 Take care in avoiding that the electrical cables connected to the BioCAM DupleX (in particular, the 
one for the power supply and for the PC Link) do not pass near other power supplies.

•	 Check that the cable connectors are well inserted into the BioCAM DupleX and the host PC before 
operating the platform.

The system allows for the integration of a perfusion system as it is needed for maintaining tissues 
during electrophysiological measures. Even if precautions have been taken in designing the system to 
prevent liquids in entering into contact with the internal electronics, spill outs of electrophysiological 
solution that might get into the HD-MEA slot should be strictly avoided. However, should this happen 
please follow the following steps:

1.	 Immediately unlock and remove the HD-MEA and switch OFF the BioCAM DupleX. 

2.	 Accurately clean the HD-MEA Bay of the BioCAM DupleX with ethanol >96% and let it dry. Execute 
the same procedure for all the HD-MEA parts but for the HD-MEA reservoir and in particular for the 
HD-MEA connector pads. 

3.	 In case after the cleaning with ethanol, there are still doubts that some liquid could have penetrat-
ed into the BioCAM DupleX, do not switch on the system for at least one day, allowing the liquid 
to be completed dried and preserving internal circuitry from potential oxidative and short-circuit 
effects. 
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HD-MEA handling and use 
HD-MEA are low-power active electronic circuits and it is highly recommended to avoid the following 
operations that might result in a damaging of their electronics:

•	 Do not touch the contact pads of the HD-MEA. Electrostatic charges might damage the on-chip cir-
cuits and might result in damaging the device. Always handle the HD-MEA by holding it on the sides 
and ideally by using plastic gloves. 

•	 Do not hold the HD-MEA by its reservoir to avoid detaching it. 

•	 Do not touch the active area of the HD-MEAs with any tools except those specifically allowed (see 
“Cleaning procedure for HD-MEA“ P.17). In particular, hard or semi-hard objects (e.g. metal or plastic 
tools) can irreparably damage the electrodes and the on-chip circuits.

•	 For cleaning or for sterilization, avoid immersing the entire HD-MEA in water or ethanol. Prolonged 
immersion in water of the entire HD-MEA might cause oxidation of the contact pads. In ethanol, some 
parts of the HD-MEA might be deteriorated. As a general rule only the chamber can be wet while the 
rest of the chip should stay dry. 

•	  It is highly suggested not to place  the HD-MEAs in autoclaves, ovens or under UV-light exposure for 
sterilization. These methods might deteriorate the CMOS devices, resulting in malfunctioning or in re-
duced lifetime. For the HD-MEA sterilization, please refer to the “Sterilization procedure for HD-MEAs“ 
.P.18.  

•	 Maintain the pH of the electrophysiological solutions used for neuronal cultures or brain tissues pos-
sibly at physiological conditions (7-7.5). Important changes in the pH of the solution might damage the 
electrodes.

During recordings (both cultures and brain tissues) users have to comply with the following precautions: 

•	 Before contacting the HD-MEA into the BioCAM DupleX, clean the metal pad contacts with a tissue 
paper soaked with ethanol 96% and let it dry for few seconds.

•	 Avoid liquids to spill out and strictly avoid liquids in entering into contact with the pads (the BioCAM 
system is equipped with a Bay Barrier to protect the connecting socket). In case users experience 
liquid spill out, follows instructions provided in the “BioCAM DupleX handling and use“ P.16 section.

In order to ensure a good quality of the recordings:

•	 Avoid using HEPES (4-(2-hydroxyethyl)-1-piperazineethanesulfonic acid) in the solutions used for 
electrophysiological recordings, since we observed that it can interfere with the electrodes, making 
the chip unstable and the recordings very noisy.

•	 HD-MEAs are light-sensitive devices and their performances might be affected by a too highly inten-
sified direct exposure or by noisy light sources. 
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Cleaning procedure for HD-MEAs
Normal cleaning
It is a good practice to clean the HD-MEAs immediately after the experimental recordings both for cell 
cultures as well as brain tissues. First, rinse the HD-MEAs abundantly with Double Deionized Water 
(DDW), then fill the chambers with a detergent such as WPI-Enzol (WPI) or Terg-A-zyme (Alconox) and 
gently pipette for a few seconds. Leave the detergent for a few minutes (typically 3-5 min) and then 
pipette again. 

After the use of the detergent, rinse the HD-MEAs abundantly with DDW, then leave the chamber filled 
with DDW for 1-2 minutes and repeat this operation 3-4 times in order to be assured of washing out the 
detergent completely.

Intense cleaning
In case the chips are very dirty, users can mechanically remove cellular debris with a soft brush. Be 
aware that this operation can damage the sensing area of the chip, so it is suggested only if, after a 
normal cleaning procedure, the chips still presents dirtiness and in any case it has to be performed very 
mildly and carefully. 

Finishing and storage
HD-MEAs can be dried by using a gentle flux of Nitrogen air (do not directly expose the recording area 
to the flux to avoid potential electrode damages). Alternatively let the HD-MEAs dry on a bench by cov-
ering them with a plastic petri dish to avoid dust deposition on the recording area. 

The HD-MEA’s area out of the chamber can be cleaned with a tissue soaked in ethanol >96%. It’s a good 
practice to always wear gloves while handling the chips.

Once the HD-MEAs are dried they should be stored in a closed box in order to protect them from dust 
and dirtiness.

As a general rule, avoid sterilizing or using ethanol in the HD-MEA chamber without having preventively 
cleaned the chip from cellular debris of previous experiments. Alcohol can fix biological materials on the 
recording area of the chips, however it will result in a degeneration of the signal recording performanc-
es. 
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Sterilization procedure for HD-MEAs
As indicated in the previous section, it is highly suggested not to place HD-MEAs in autoclaves, ovens or 
under UV-light exposure for sterilization purposes. These procedures risk deteriorating the chips result-
ing in not optimal recording performances and a shorter chip lifespan.

To sterilize chips, first perform a cleaning procedure as indicated in the previous ”Cleaning procedure 
for HD-MEAs” P.17 and adopt the following procedures (that has to be performed under a biological 
hood):

1.	 Clean the areas of the HD-MEA outside the reservoir (including the external part of the reservoir  
itself) by using a tissue soaked with ethanol 96% and put it inside sterile plastic petri dishes. 

2.	 Fill the reservoir completely with ethanol 70%. Also dip the border of the reservoir (the tiny up-
ward-oriented side of the ring) with the same solution. Proceed to wait for 20 minutes. 

3.	 Suck the ethanol with a pipette or with a vacuum pump, always using sterile tips. 

4.	 Fill 3/4 of the reservoir of the HD-MEAs with sterile DDW, wait a few seconds and always suck the 
liquid with sterile tips. Repeat these operations 4 times in order to ensure of washing out the etha-
nol completely. When removing sterile DDW for the last time, be sure to have completely dried the 
chamber. Aspirate the liquid on the recording area by always keeping the tip close to the reservoir/
CMOS border but not touching the CMOS to avoid any risk in damaging the electrodes. 
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Installing BrainWave 4
The Brainwave 4 software will be found already installed with your BioCAM DupleX platform. However, 
due to any other circumstances you can still search, download and install BrainWave 4 directly from this 
link:  http://www.3brain.com/resources/downloads

Setting up the BioCAM DupleX
1. Plug the power supply cable into the power port located in the back of BioCAM DupleX and then
connect the power supply into an electrical outlet. Switch ON the DupleX by pressing the power but-
ton on the back. The DupleX’s Power LED light should turn ON.

2. Turn on the host PC, plug one end of the PC link into the USB C port on your host PC and the other
end of the PC link to the DupleX. The USB Type-C (v.3.1) cable is provided with the DupleX. If you
require another, please ensure to purchase the Type C with at least or above version 3.1.

3. Launch BrainWave 4 and verify that the DupleX is properly recognized by checking that the LED icon
in the BrainWave’s Right Status Bar is turned ON, with the display of DX to indicate it’s recognition of
the DupleX platform, as indicated in previous section “BrainWave 4“ P.13.

Plug the HD-MEA
HD-MEAs are connected to the BioCAM DupleX through the lock system. Once a HD-MEA is inserted 
into the HD-MEA bay of the BioCAM DupleX, press the lock button to initiate the locking mechanism.

1. Insert the HD-MEA into the DupleX sliding it along the HD-MEA bay. The HD-MEA should enter into
the DupleX’s HD-MEA slot till the distance between the end of the HD-MEA and the DupleX’s end
is approximately about 8mm(1/3 in). If the HD-MEA is not at it’s end position, the LED for the locking
indication will display red. Repress the lock button to release the lock and try to re-insert the HD-
MEA again

2. Once you’ve push the lock button, and the locking mechanism has recognized the correct plac-
ment of the inserted HD-MEA. The LED lightning indicators on the device should turn ON, as
indicated on the next section “Verifying proper functioning“ P.21 . BrainWave 4 should recognize the
input of the HD-MEA with it’s Status Bar displays, as shown on “BrainWave 4” P.13.

8mm 
distance

http://www.3brain.com/resources/downloads
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Verify proper functioning
Once you have installed and turned on the BioCAM DupleX, incase there are any updates, BrainWave 
will notify you to update on the host PC . You can easily verify the proper functioning of the system by 
the following check list:

1.	 Verify that both DupleX LED and HD-MEA LED icons in the BrainWave’s Right Status Bar are ON (see 
section ”BrainWave 4” P.13).

2.	 On BrainWave go to File > New Recording Session . On the new opening window click on the Play 
button to start, the “Status” LED on the BioCAM DupleX will turn on. Select a few channels to open 
their graphs (see “Visualize live data” P.27) and verify that the data is acquired from the HD-MEA (if 
you have not placed a living sample on it, you should visualize noise traces in the range of +/- 40 
µVolt)

If anything of the above went wrong, please check “Troubleshoot” P.37. If the problem is still not solved, 
contact the customer support. 

Unplug the HD-MEA :
1.	 Press the BioCAM DupleX’s lock button, blue lights should move from the locked to unlocked on the 
HD-MEA lock LED indicator. 

2.	 Once the light indicates the HD-MEA as unlocked, simply remove from the slot.

HD-MEA lock indicator

Recording status indicator
Power indicator



22

Quick guide to 
your first use

5



23

Basic concepts

Visualization of data
BrainWave 4 makes use of tools designed to manage high resolution data coming from CMOS-MEAs. 
This has been implemented by combining conventional approaches with innovative ones. In particular, 
since HD-MEAs act as “cameras for extracellular electrophysiological potentials”, several functionalities 
were introduced following similar approaches as used in multimedia.

BrainWave 4 is an all-in-one software including tools for recording, visualizing, analyzing and exporting 
your data. Use of BrainWave 4 differs based on whether you are visualizing live data from your biological 
preparation or whether you are playing back data previously recorded. These two different scenarios 
are referred as online mode and offline mode respectively.

The term Experiment can be used both for an online and an offline experiment. When a new Experi-
ment is started (online) or opened (offline), its data is loaded and displayed in the BrainWave 4’s Exper-
imental viewer area. More Experiments can be loaded during a single application session, in particular 
you can manage at the same time multiple offline Experiments and one single online Experiment. When 
multiple Experiments are open, they are organized in tabbed documents. When passing from an Ex-
periment to another by clicking on its corresponding tab, BrainWave 4 updates all the windows with the 
Experiment’s data.

In Brainwave 4 there are two experimental visualization modes. 

Online : Real time, when you access the live data from a biological sample on a HD-MEA chip. This data 
can be visualized directly and/or recorded to your hard disk.

Offline: refers to playback and analysis of recorded experiment’s data

Windows

Tabs         
click on a 
tab to select 
a different 
experiment

Experiment
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MEA Viewer control
Electrodes integrated in the CMOS-MEA are referred in BrainWave as Channels (abbreviated Ch). A 
fundamental control to browse your data is the MEA Viewer

MEA Viewer displays the activity at the current time position by a false-color map. The map gives a 
representation of the activity by converting the channels’ voltage values in your MEA to pixel colors. This 
is done according to the color scale below and settings. At a specific time location in your recorded Ex-
periment the MEA Viewer gives an image representation of the activity. When instead you visualize live 
data acquired from the HD-MEA or when you playback recorded Experiments, the MEA Viewer refresh-
es continuously, thus creating an activity movie. 

Each square pixel in the MEA Viewer represents a channel in your MEA. Channels are identified by their 
row and column coordinates. By convention row coordinate comes first than column coordinate, hence 
for instance the channel [10, 5] is the channel at row 10 and column 5.

MEA Viewer allows you to select single or multiple channels. To select multiple channels you can either 
hold down Shift on your keyboard while clicking on channels or click and drag an area over the MEA 
Viewer.

Color scale                
for current settings

Settings                                          
affecting the way the channels’ voltage 
values are converted to colors

MEA Viewer                                  
representation of the voltage values of the 
channels by a color map

Hover and click                                   
to select channels. Hold .shift to click 
and select multiple individual channels. 
Clicking and dragging an area will select 
multiple channels in the boxed area.
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Data formats
BrainWave 4 works with two main file types although it can export data in other formats. Those two own 
file types are BRW- and BXR-files. Both file types are using HDF5 hierarchical data format (hdfgroup.org). 
You can easily open them within most operating systems (including Windows, Linux and Mac OS) and 
most used data analysis environments, such as, among others, Python, Matlab, Scilab, Octave and R. 
You can find detailed documentation on both data files on 3brain.com/resources/downloads.

BRW stands for Brainwave RaW data file and contains continuous or qua-
si-continuous data streamed from the the BioCAM. BRW files, according to 
your acquisition settings, can contain for instance raw data recorded from 
all the HD-MEA channels or a temporal subset of those data. The following 
section will teach you how to record plain raw data file.

BXR stands for Brainwave eXperiment Result data file and contains discrete 
data obtained by analyzing and processing the raw data. BXR files can for 
instance, contain the timestamps of the detected spikes. In the following 
section you will learn to create a BXR-file starting from a BRW-file.

Conceptually, a BXR-file is created starting from a BRW-file, hence a BXR-file is associated and linked 
to its parent BRW-file (while it is not true that a BRW-file is linked to a BXR-file). BXR-file can be deleted 
and recreated starting from the BRW-file, while if a BRW-file is deleted the contained data is lost for-
ever. However, since BRW-file are typically large files containing a huge amount of information, some-
times you might find useful to delete the BRW-file once the relevant results have been obtained and 
saved in a BXR-file.

http://www.hdfgroup.org
http://www.3brain.com/resources/downloads
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Online mode (Record mode)

Important notes
Before moving forward, follow all the steps detailed in “Install the BioCAM DupleX” P.20 and “Plug the 
HD-MEA” P.20 Hence, make sure that the BioCAM DupleX and the HD-MEA are properly connected by 
checking that the corresponding LED icons in the BrainWave 4’s Right Status Bar are turned ON (blue 
icon).

Open recorder
Open the recorder by either 

•	 Choosing File > New Recording Session, or 

•	 Right-clicking on the Workspace > New Recording Session, or

•	 Pressing Ctrl+N

A new online Experiment opens as a tabbed document. Only one online Experiment can be open 
during an application session and it can be identified by the  icon and the “Recorder” text on the docu-
ment tab.

File > New Recording Session 
or Pressing Ctrl+N

Right-clicking on the Workspace >               
New Recording Session
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Visualize live data
To start an acquisition and visualizing data read out from the HD-MEA:

1.	 Click Play under the Commands window  to start the acquisition. The MEA Viewer starts refreshing 
and displaying data. 

2.	 Click on the MEA Viewer to select individual channels or Shift-click to select more channels. For each 
selected channel a new chart is plotted on the right showing the voltage data being read out from 
that channel. 

3.	Use the Chart window to adjust channels’ charts. Two controls are available on the Chart window for 
both the time (X) and amplitude (Y) axis scale values of the charts. The time control regulates the 
time window used by the charts. By selecting a given time window width (e.g., 500ms) the charts are 
refreshed by periods of the same time duration. The amplitude control allows the selection of the 
Minimum and Maximum values visible on the charts in the Y axis.

To stop the acquisition simply click on the Stop button under the Commands window.

Recording tab

2. Select Channels     
by clicking on the MEA 
Viewer. To select more 
channels hold Shift.

Selected channels are 
visualized in individual 
charts.

3. Chart window                                                                  
to adjust charts scale by dragging bars for time window width 
and for amplitude range.

1. Click Play                                                                      
to start an acquisition.

MEA Viewer starts to display data coming from the HD-
MEA by converting MEA channels’ voltage values into a 
colored movie.
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HD-MEA Calibration
In the case of when you experience several electrodes  within short or prolonged periods of time with 
no visible signals, you may be experiencing a signal saturation problem. In this case, follow these steps 
before proceeding on with recording data.

A typical example of a HD-MEA with saturating behavior is illustrated in the image below. On the left, the 
MEA Viewer shows many deep blue colored pixels indicating not working channels while on the right 
typical raw data traces with short periods of saturation (top-left, top-right and bottom-left) or even with 
persistent saturation (bottom-right) are shown.

This behavior might be related to a wrong setting of the working point of the amplifiers that are integrat-
ed underneath the electrodes. In such case, follow the instructions below for a correct HD-MEA calibra-
tion; if the problem persists you can refer to the section “Electrodes with no-signal (saturation)” P.38.

BrainWave features two functions to perform HD-MEA calibration: an automatic and a manual proce-
dure. The automatic calibration button is positioned on the right of the window. To perform an automatic 
calibration you first need to start an acquisition (by clicking on the Play button) and then to click on the 
Auto button. The procedure will take from few tens of seconds up to roughly a minute, depending on 
the HD-MEA conditions.

If automatic calibration is not satisfactory you can perform a manual calibration. From the window you 
can move the sliding bar to set a value for the amplifier bias that minimizes the saturation of the elec-
trodes. Normally, value in the range of Prime Arena and Stimulo: -300 to -400 and Accura: 0 to 150 
allows to achieve good performances, but values out of this range can also be needed. Moving the bar 
toward higher negative values will eliminate saturation from those electrodes that oscillate between 
working condition to saturation (i.e. blinking deep blue pixels in the MEA Viewer control). If you set a too 
high negative value, some electrodes will start saturating permanently (i.e. fixed deep blue pixels in the 
MEA Viewer control). For a correct setting start from values close to 0 and move the bar by small steps 
towards the left until an optimal condition is found.

Auto button
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Record live data
Complete the steps to “Visualize live data” P.27 and then:

4.	Click the browse button on the Info window to choose the path where to save your data. Be aware 
that to safely record from high resolution MEA you need high performance hard disks. Hence, browse 
to a file located either on a high-end disk (e.g., SSD; solid-state drive) or on a disk pool configured with 
RAID 0 (striping). If your order included a pre-configured host PC, the disk partition where you should 
record your file is typically labeled with LiveRec or RAID0. Once you chose the path, by default Brain-
Wave 4 selects for you the file name, but you can modify this by typing in the Name field.

5.	Choose the length of the experiment you want to record by bearing in mind that the experiment will 
last this duration or shorter, in case you stop the recording ahead of time, but not longer.

6.	Click the Play button in the Commands window to start recording. In the Progress  window you can 
see the elapsed and remaining time of the recording.

7.	 Wait until the set experiment length or click the Stop button at any time to finish recording. The re-
corded file is a BRW-file located at the position you selected in step 4.

4. Click browse 
button

5, Choose the 
duration                                                                  

Progress window : a bar indicates the progress 
of the recording

to choose the re-
cording destination 

path.

of the experiment 
to record.

6. Click play to record. 7. Wait for the set time or click 
Stop to finish recording.

http://en.wikipedia.org/wiki/Solid-state_drive
http://en.wikipedia.org/wiki/RAID
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Offline mode (Playback mode)
The tutorial contained in this section is based on the demo file on dissociated neuronal cultures you can 
find on 3brain.com/resources/downloads. Download that file and then extract it to a known location by 
using 7-Zip or WinRAR.

Open recorded data
Locate the demo BRW-file to open. Then to open it in BrainWave 4 do one of the following:

•	 Choose File > Open, or 

•	 right-click on the Workspace > Open, or 

•	 press Ctrl+O, or 

•	 drag the file from Windows Explorer into BrainWave 4, or

•	 double-click on the file in Windows Explorer.

A new offline Experiment opens as a tabbed document. The tab name is the name of the BXR-file as-
sociated to the BRW-file. Since you have open a BRW-file and no BXR-file has still been created the tab 
name will be in the form “Untitled-X”, being X a progressive application session-wide number. Hence, if 
this is the first file you open in this session it will be named “Untitled-1”.

The offline Experiment tab and the windows are similar to the online case, however some controls and 
functions change.

Timeline window
to browse to specific 
time positions.

Info window
reports the path to the 

BRW-file (if existing 
and properly linked) 
and to the BXR-file (if 

already saved).

Vertical tabs
to access Experi-

ment-specific further 
data and statistics.

http://www.3brain.com/resources/downloads
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Quick analysis and save of results
As a first step, we perform a spike detection on the loaded data. Choose Analysis > Peak Detection 
from the Main Menu or alternatively press Ctrl+P. On the new opening window, simply leave the default 
parameters and click OK and then wait for the analysis to be accomplished.

Once finished, the BXR-field in the Info  window  turns yellow to indicate that there are unsaved data. To 
save data do one of the following:

•	 Click on the icon right to the BXR field in the Info window;

•	 Click File > Save

•	 Press Ctrl+S

Once you have saved the data, the Experiment tab name indicates that the BXR-file name and the BXR 
field in the Info window are updated too.
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Visualize recorded data
As a consequence of the analysis, notice that the Timeline bar is now filled with vertical lines whose col-
ors indicate the degree of the overall detected activity (averaged on the entire MEA) along the temporal 
axis. A blue-color indicates a relatively low activity, while a red-color a relatively high activity around that 
time position.

To browse your Experiment for signals:

1.	 Click the MEA Viewer on channel [24, 9] to open it’s chart

2.	 Click the Timeline bar in correspondence of the first red vertical line (near 0.2s). You will see the 
activity around the selected time position for the entire MEA in the MEA Viewer and the data for the 
channel [24, 9] in its chart.

Try to move to other spatial positions in the MEA by selecting other channels in the MEA Viewer (in 
particular red channels) and to other time positions by clicking or dragging on the Timeline bar. To move 
along the time axis, you can also click Play (Stop) in order to automatically playback (stop) the data 
stream or alternatively you can use the Left and Right Arrow keys on the keyboard. When Play is on or 
you use the arrow keys, the speed at which data is refreshed is given by the Speed control under the 
Timeline window. Speed can also be adjusted with the Up and Down Arrow keys.

1. Click MEA Viewer 
on channel [24, 9] to 
open its chart. 

Chart bars
indicating detected 
spikes

2. Click Timeline bar 
in corrispondence of the 
red line.

Timeline cursor
a red overlaying  rect-
angle with central, left 
and right markers

The timeline cursor centers at 
that position. MEA Viewer and 
chart refresh accordingly.

Timeline bar 
is filled with verti-
cal colored lines 
indicating the level of 
activity.

Play button Speed Control
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Understanding main controls affecting graphs

MEA Viewer Bin setting =
bin to integrate for colors = 
Charts’ overlay rectangle width

Charts Time bin =
Timeline cursor width =
Charts width

sec

24.9
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Create a group of relevant channels
You can create groups of channels according to your selection or a given statistical information. Here 
we create a group from a manual selection. 

1.	 Select a group of channels of your interest by using one of the cursor tools below the main menù.

2.	 Click the “Create new channels group...” button at the bottom left of the Channel Groups window. A 
small pop-up window will appear.

3.	 Choose a name for the group, a labeling color, and tick the “Add Selected Channels” checkbox. Then 
click the “Ok” button. 

A group of channels will appear on the Channel Group window.

1. Cursor tools

2. Create new channels group 3. Add selected channels
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Visualize Instantaneous MFR
In addition to the Global MFR it might be useful to observe the instantaneous MFR, which gives the 
trend of the MFR computing it on successive small temporal bins. To plot the Time MFR:

1.	 Right-click on Channel Groups window will show the selection to select the channels belonging 
group. An instantaneous MFR chart is plotted by summing up together all the selected channels and 
binning according to the Bin size setting in the Chart window.

To zoom the MFR chart:

2.	 Click on the AFR window to activate the MFR chart. In this way the Charts window updates to show 
the controls corresponding to this chart.

3.	Zoom the AFR chart either by using Chart window controls at the left or by altering the Bin value 
directly shown below the viewer. 

2.  Click on AFR window 
to activate the MFR chart  (Charts window 
controls ia updated to this chart). 

1. Right-click on Channel 
Selection 
then choose Select Channels 
Group > NewGroup

Instantaneous MFR chart is plotted 
by summing all the selected chan-
nels and binning according to the 
Bin size setting.

3.  AFR Settings
either by using Chart window controls on the left, or 
altering the Bin size here.
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Visualize Raster
The time raster is another common tool used to observe activity on your data.

3. Zoom on time axis
by using the Timeline bar control and moving the 
aside handlers.

1. Click on Raster tab A time raster chart is plotted.

2. Decrease X asis width
for the raster in order to have a more defined 
raster.
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Troubleshooting
6
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Electrodes with no-signal (saturation)
Symptoms
Few electrodes in the array have either persistent or short periods with no visible signal. This effect is 
overall called saturation and in this section we will refer to its two possible subtypes: persistent satura-
tion (i.e. a channel is always saturated and no signal is displayed) and jumping saturation (i.e. raw signal is 
affected by short periods of saturation typically of tens to hundreds of milliseconds). 

In the MEA Viewer control (left image) in BrainWave saturating electrodes show a lowest fixed color 
scale value (persistent saturation) or they blink toward the lowest scale value. The lowest color scale 
value is typically deep blue but may differ according to the chosen color scale. By displaying the raw 
traces of the single electrodes it is possible to see either “jumping” signals disappearing for short pe-
riods of time (right image: top-left, top-right and bottom-left traces) or no signals (right image: bot-
tom-right trace).

Causes
Saturation arises (i) when the input signal amplitude exceeds the operational range of the amplifiers 
integrated inside the HD-MEA’s CMOS or (ii) when the amplifiers working range is not properly set. In the 
first case, this could be due to invalid signal input, for instance; in the second case a wrong calibration of 
the HD-MEA could be the cause. 

Possible scenarios and remedies
# Scenario Remedy
 S1 Electrodes on the HD-MEA are insulated by 

tiny bubbles that form when adding a saline 
solution because of the hydrophobicity of the 
CMOS surface. Insulated electrodes exhibit 
persistent saturation because the input signal 
is missing.

This scenario arises only when trying a new 
HD-MEA or a HD-MEA that has not been used 
for a long period. A 2x or 4x magnification 
lenses are enough to observe these bubbles.

Use a plastic pipette with a small tip to flow 
liquid on the CMOS surface in order to remove 
the bubbles. While doing so, be very careful 
not to touch the CMOS and to avoid electrodes 
damages.

Alternatively empty the chip’s reservoir, put a 
drop of pure etoh on the recording surface for 
a few seconds, rinse with water and put back in 
the solution
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# Scenario Remedy
S2 CMOS is exposed to too high an environ-

mental light source and it is not properly 
configured to work in such conditions. In such 
scenario several electrodes typically exhibit 
jumping saturation.

Turn off the light source or cover the HD-MEA 
with a cap (as those that can be provided to-
gether with the BioCAM DupleX system). 

If you cannot perform this operations, or if you 
need light on the HD-MEA (e.g. for light stimu-
lation purposes) configure BrainWave to make 
the HD-MEA working in such conditions.

If the problem is not solved, check following 
scenarios and remedies.

S3 This can happen for the Arena, Stimulo, and 
Prime chips, where the pseudo-reference 
electrode is dirty or it has not been cleaned 
for a relatively long period. Proteins and im-
purities can attach with time to the reference 
electrode and degrade the reference per-
formances, causing few or many channels to 
exhibit persistent saturation.

Check section “BioCAM DupleX handling and 
use” P.15 how to clean the pseudo-reference 
electrode.

S4 HD-MEA is not properly calibrated. In such 
scenario some channels might show per-
sistent saturation while others suffer from 
jumping saturation.

Check section “HD-MEA Calibration” P.28 to 
calibrate the chip.

S5 HD-MEA is either damaged or worn out. If none of the above remedies worked you may 
need to change the HD-MEA.
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HD-MEA not properly initialized
Symptoms
On the MEA Viewer control in BrainWave, large red horizontal stripes move up or down across the entire 
array.

Causes
HD-MEA are monolithic CMOS-MEA chips integrating active semiconductor components (i.e. transistors)
underneath and around the active area (i.e. the area exposing the sensing surface of the electrodes). 
Some of these active components need to be correctly biased by sending configuration settings from 
BrainWave to the BioCAM and the HD-MEA before starting the read out of the data. This operation is 
performed when starting the acquisition in BrainWave (e.g.by clicking Play button). If the connection to 
the HD-MEA is not in place or it is compromised, the initialization of the chip will fail.

Possible scenarios and remedies
# Scenario Remedy
 S6 BioCAM locking system (see section “Plug 

the HD-MEA” P.20 ) was in the unlocked state 
when acquisition was initiated.

Stop the acquisition, make sure that the HD-
MEA is properly inserted till the end of its bay 
and push the Lock button of the BioCAM Du-
pleX to its end position (see section “Plug the 
HD-MEA” P.20 for more details). Make sure that 
the HD-MEA LED icon on the BrainWave’s Right 
Status Bar (see section “BrainWave 4” P.13) is on, 
signalling that the HD-MEA is properly inserted 
and locked. Restart the acquisition.

If the HD-MEA LED icon on BrainWave does 
not turn on, see following scenarios.
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# Scenario Remedy
S7 HD-MEA contact pad is dirty or damaged. Extract the HD-MEA from the HD-MEA bay and 

clean all the gold contact pads on the HD-MEA 
by using a tissue soaked with pure ethanol 
(>96%). 

In case you observe some dirt on the pads you 
can also try to remove it by using a soft rubber.
Be careful not to damage or remove the gold 
layer covering the electrical contacts. Then, 
clean again with pure ethanol and let it dry for 
at least one minute. 

If cleaning has no effect, try one or more differ-
ent HD-MEAs to verify the problem does not 
lie in the BioCAM. If also other HD-MEAs exhibit 
the same problem, go to next scenario.

S8 BioCAM DupleX locking mechanism, which 
is responsible to connect the HD-MEA to the 
BioCAM, is damaged.

Double check if the locking LED shows red 
during the locking state. If it does, hovering 
over the LED should indicate the problem.

However please contact customer support.. 
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Not working columns
Symptoms
Groups of 4 columns do not work. This typically happens on 4 columns but might also involve 8 or 12 
columns and in any case a multiple of 4 columns (columns are grouped by 4 in the multiplexing logic). 
If you see only part of a column or a single column in a non-working conditions, then the HD-MEA is in-
herently damaged at that location. In most cases it is still possible to record from the remaining working 
electrodes.

Causes
One or more of the lines that go from the HD-MEA to the BioCAM DupleX exhibit a faulty connection. 
This issue typically occurs between the HD-MEA contact pad(s) and the DupleX bridge module inte-
grated inside the mechanical locking system. 

Possible scenarios and remedies
Check scenarios “S7” and ”S8” in previous sections.
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HD-MEA with dirty surface
Symptoms
This scenario can occur when testing a HD-MEA with no biological preparation. The chip might not have 
been properly cleaned or has not been used for a long period. In this situation, several electrodes on 
the array could exhibit either higher level of noise or signals with fake peaks. In BrainWave, you typically 
see several spots (single electrodes) with red values on the overall array (left image) . Single electrode 
raw traces can have either high noise levels (centre image: bottom traces are more noisy than average 
traces on top) or peaks at a sustained pace (right image). Most of the peaks have a shape quite different 
from that of a real spike, but some might still look similar.

Causes
HD-MEA CMOS surface is dirty, which makes some electrodes unstable.

Possible scenarios and remedies
# Scenario Remedy
 S9 HD-MEA electrodes are dirty of debris and/or 

more likely of dust particles.
While the chip is connected and is filled with 
saline solution, start acquiring and visualizing 
incoming data with BrainWave to have a feed-
back on whether the problem is solved. 

As a first step, try pipetting with a small plastic 
pipette by placing the tip roughly at 45° and 
very close to the CMOS central area. Be very 
careful not to touch the CMOS with the tip.

If this does not help, you can also try to use 
a soft brush directly on the CMOS surface by 
gently brushing repeatedly until all the instable 
electrodes get recovered.
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Causes
The gold pad pseudo reference is hydrophobic and some air are kept trapped at the reservoir border.

Possible scenarios and remedies
# Scenario Remedy
 S9 Pseudo-reference electrode on HD-MEA has 

bubbles causing extra noise collected into the 
electrophysiological imaging.

Use a small plastic pipette to suck out the 
bubble

Pseudo-Reference Electrode bubbles
Symptoms
This scenario occurs when bubbles have formed above the pseudo-reference electrode within the HD-
MEA. This can create excess noise on the recordings. 
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Contact information
If there are any further questions which you would like to personally contact us for 
assistance with. Please feel free to contact us through the following link:

https://www.3brain.com/contact

For urgent communications contact: 

Phone: +41-813227086
Email:    info@3brain.com

https://www.3brain.com/contact

